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Abstract 

Civil engineering students learn about basic geomaterial properties in the introductory 
geotechnical engineering or soil mechanics course, which is typically taken during the junior 
year of the Bachelor of Science degree program.  Introductory soils courses most often include 
laboratory sessions in which students conduct simple destructive tests such as sieve analyses, 
Atterberg limits, and compaction tests.  Unfortunately, there is no standardized or readily 
implementable test for evaluating the engineering influence and significance of soil fabric and 
micro properties.  Textbooks and instructors emphasize the importance of soil texture, void ratio, 
porosity, and phase relationships; however, students often struggle with the physical meaning 
and significance of these fundamentally important parameters.  Introducing geo-students to x-ray 
computed tomography (x-ray CT) helps alleviate a common issue in the geotechnical discipline; 
which is, some students lose interest early in the semester because of the simple, low-tech 
(crude), testing that is typically conducted during the first few weeks in introductory soils 
courses.  The high-tech flavor of x-ray CT can be attractive to these students.  An additional 
attribute of this approach is that the procedures described herein can be implemented for teaching 
purposes using open domain software and scanned digital images.  Consequently, these 
experiments can be implemented by engineering departments regardless of their accessibility to 
an x-ray CT scanner.   

Introduction 

This paper presents a novel approach for implementing x-ray computed tomography (x-ray CT) 
into an introductory soil mechanics course.  Non-destructive systematic methods are described 
for incorporating x-ray CT into an introductory soils course to quantify microscale measurements 
of solid particles and void space using scanned digital images.  Introducing geo-students to x-ray 
CT technology helps alleviate a common issue in the geotechnical discipline; which is, some 
students lose interest early in the semester because of the simple, low-tech, testing that is 
typically conducted during the first few weeks in introductory soils courses.  The high-tech 
flavor of x-ray CT can be attractive to these students.  An additional attribute of this approach is 
that the procedures described herein can be implemented at a relatively minimal cost using open 
domain software and scanned digital images.   
 
The objective of the exercise is to help students better visualize and understand fundamental soil 
attributes including void ratio, gradation, and porosity in a learning environment that may be 
more attractive or customary to new engineers growing up in a digital age.  Students are 
introduced to a relatively new technology that allows visualization of the internal structure of 
objects – a launching point for combining visualization and simulation with physical 
measurements and perhaps analytical or numerical modeling.  The objective is not to provide 
detailed tomographic or radiologic training, but rather to focus on applications that are useful in 
the geo-industry.   
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This paper provides a brief overview of x-ray technology followed by a detailed description of a 
novel pedagogical application of this technology.  The newness of this approach precludes the 
presentation of statistical assessments.  However, anecdotal comments from students using this 
approach have been positive and encouraging.  A more quantitative assessment of student 
learning will be assembled in future semesters based on a compilation of student feedback using 
written surveys and questionnaires. 

Background 

The mechanical behavior of granular soils is highly dependent on the particle microstructure.  
The microstructure is commonly referred to as the soil fabric, which includes the shape, 
distribution, and arrangement of particles and void space.  Because of the inherent difficulties in 
measuring soil properties on a microscale, geotechnical engineers use macro properties to 
estimate, or predict, the response of soil when subjected to changes in the state of stress.  These 
macro properties (void ratio, porosity, density, uniformity, etc.) are used to represent gross or 
average measures of the soil microstructure in terms of engineering behavior; i.e., strength, 
compressibility, and permeability.   
 
The non-destructive nature of CT scanning allows the same soil or rock sample (geomaterial) to 
be scanned multiple times.  Because the soil structure is not affected by the procedure, CT 
scanning provides an opportunity to investigate particle and pore characteristics at any time and 
location within a sample.  High quality digital images can be obtained of the microstructure 
during loading or during environmental changes, such as fluctuations in temperatures or 
moisture.  Tomographic studies on geomaterials conducted during the past two decades(1, 2, 3, 4) 
indicate that x-ray CT technology provides a viable means for nondestructively observing, 
measuring, and quantifying the internal microstructure of geomaterials. 
 
X-ray computer-aided tomography (CT) provides an alternate approach for measuring soil 
microstructure.  An x-ray CT scan consists of two processes: 1) data collection and 2) image 
reconstruction.  During the data collection stage, a specimen is digitally photographed from 
multiple angles as it is exposed to x-ray beams.  X-rays are invisible, high-energy 
electromagnetic waves that are able to pass through many objects.  X-rays that penetrate an 
object will encounter an x-ray sensitive screen within the CT apparatus and cause it to illuminate.  
During x-ray exposure, the object’s matter will absorb some of the x-rays and the intensity 
(energy per unit area per unit time) of the x-ray will attenuate as it is absorbed and scattered by 
the atoms of the material.  A material with high density will attenuate more x-rays than a low-
density material; therefore, two materials of different densities will appear differently in an x-ray 
image.  This allows the distinction between different phases of material in a soil specimen; i.e., 
mineral particles, water-filled voids, and air-filled voids may each appear distinct within an x-ray 
image. 
 
A digital camera is used to capture the image on a luminescent phosphor screen, which replicates 
the x-ray penetration pattern of the object.  The pixel intensity (gray-scale shade) in the CT 
image provides a measure of total attenuation, which is a combination of the mass attenuation 
and mass density of the material.  This attenuation is quantified using the linear attenuation 
coefficient(5).  In terms of CT imaging technology, the linear attenuation coefficient is related to 
the density of a pixel and is useful for distinguishing and quantifying different constituents of a 
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specimen.  A typical x-ray equipment configuration for what is known in the industry as a third 
generation fan beam scanner is shown in Fig. 1.   
 
 
 

 
 
 
 
 
During the image reconstruction phase, photographs of multiple x-ray scans are digitally 
superimposed in such a way that the resulting image describes the interior structure and features 
of the specimen.  When the scan is reconstructed, the resulting image is a cross-sectional view of 
the object as if it had been cut through the plane at the scan location.  The CT scanning 
equipment at the author’s university is capable of performing scans at increments as small as 1/8-
degree of rotation.  The author’s system, similar to that shown in Fig. 6, is a 2-dimensional (2-D) 
system, which can be used to create a 3-dimensional (3-D) image by combining multiple images 
(slices).  Newer generation 3-D systems are available that can be used to capture a full, high 
resolution, 3-D image of a geo-sample with one scan.  Similar 3-D equipment is used in the 
medical industry; although, higher x-ray energies are used when scanning geomaterials to 
improve the resolution of these particles, which have higher attenuation factors than tissue and 
organs in the human body. 

Basics of X-ray Image Processing and Reconstruction 

After a sample is scanned, the recorded data is assimilated into a meaningful digital 
representation using computer-based algorithms.  Converting recorded x-ray data into a digital 
image is one of the primary functions of computed tomography.  A reconstructed tomographic 
data file provides a quantifiable description of solid particles and void spaces in a series of two-
dimensional cross-sectional images, which also can be combined together to create a three 
dimensional volume view of the scanned object(7).  Each pixel of a scanned image represents the 
average density of a voxel (volumetric representation of a pixel) at a particular (x, y) location.  
By combining many images obtained at close spacings, a quantifiable estimate of the void space, 
porosity, or solid particulate distribution can be obtained.  Image processing can be conducted 
using a variety of commercially available software packages.  The approaches described in this 
paper utilize the open source software titled ImageJ, which is an image analysis program 

FIGURE 1.  Typical laboratory x-ray configuration(6). 

P
age 22.1717.4



 

 

 

originally developed by scientists from the National Institutes of Health.  The software can be 
downloaded from the developer’s website along with numerous ‘plug-in’ subroutines that 
provide enhanced image reconstruction and processing applications.   
 
Digital images suitable for collecting information about the internal structure of a soil sample can 
be used for making quantifiable measurements of basic properties such as void ratio, porosity, 
density, and grain size.  These properties are calculated from a raw CT image using a series of 
steps that can be categorized under the following three headings: 1) filtering, 2) thresholding, and 
3) measuring and digitizing the image.  Background and information regarding these steps are 
described in detail by Nielsen and Mokwa(8).  This paper focuses on the applications after an 
array of digitally recorded x-ray data (sinogram) is assembled and reconstructed into a cross-
sectional slice (tomogram). 

Preliminary Steps for Developing a Working Digital Image 

Prior to obtaining a digital image, the sample must be sized and prepared for the x-ray scanner.  
Soil samples are typically placed in a stiff-walled plastic container by either raining or fluviation 
methods or by placing the soil in layers and compacting using controlled repeatable dynamic 
impacts from a rammer or weight.  Rock cores should have a flat smooth end to minimize 
wobbling and eccentricities if the scanner contains an internal platen that rotates during scanning.  
Even snow and ice samples can be scanned for useful measurements; however, these sensitive 
materials require extra preparation steps and of course must be prepared and tested at sub-
freezing temperatures.  The scanner at the authors’ university was constructed to work with an 
internal chilling unit.  Some smaller scanners can be placed entirely in a climate controlled cold 
room for this purpose.  Figure 2 shows a cylindrical sample inside our x-ray scanner.  
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 FIGURE 2.  Interior view of x-ray scanner equipment. 
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The sample is placed in the device and exposed to high energy electromagnetic waves (x-rays).  
The severity of x-ray attenuation is a function of the thickness and density of the material.  The 
intensity of the emerging x-ray beam is measured and digitally recorded.  Raw data files created 
during the scanning process are converted to a file with a Dicom file extension, which is an 
acronym for Digital Imaging and Communications in Medicine Format.   
 
The basic (simplified) steps described in the previous paragraph can be explained to the students 
with as much, or little, detail as necessary depending on available time in the class schedule.  The 
hands-on aspect of this exercise begins with either a Dicom file obtained with the CT 
reconstruction software, or simply a jpeg file of the CT image (or even a photograph).  Either file 
types are readily input into ImageJ for editing, manipulating, and analyzing electronic images of 
the scanned samples.  The Dicom option is especially useful for evaluating a stack of multiple 
images (slices) at one time.  The advantage of jpeg files is they are more readily available and do 
not require CT reconstruction software.  The following paragraphs provide a step-by-step outline 
that can be implemented in an introductory geotechnical engineering or soil mechanics course. 

Step 1. 

Open ImageJ and click the File tab, then Open.  Select (double click) the appropriate jpeg file 
that contains an image of a scanned 2-D slice.  Alternately, if a series of images is available, 
click File, Import, Image Sequence, and double-click on the first file.  This will automatically 
load the series (stack) of files.  An image similar to the gravel slice shown in Fig. 3a will appear 
on the computer screen. 

Step 2. 

This step invokes a filter in ImageJ that removes background noise from the image by applying a 
pixel shading correction and a smoothing feature.  In addition to improving image clarity and 
contrast, the filter allows for an easier and more accurate manual selection of a threshold value 
from the image histogram.  Figure 3a shows the unfiltered image and corresponding histogram.  
Fig. 3b shows the same image and corresponding revised histogram after the Bandpass filter is 
applied.   
 
Select the Process tab, FFT option, and Bandpass Filter option.  Start with the settings shown in 
Fig. 4, which are often reasonable for sand to gravel size particles based on multiple comparison 
analyses by the authors.  These settings would be a good starting point for any geomaterial; 
however, the accuracy can be improved by further optimizing the settings through trial and error.   
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FIGURE 3.  A 2-D x-ray CT image of gravel: a) original image as imported 
into ImageJ and corresponding histogram, b) image after Bandpass Filter 
processing and corresponding histogram. 

FIGURE 4.  Screen shot for suggested initial settings for Bandpass Filter 
option. 

(a) (b) 
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Step 3. 

For an 8-bit image, there are 255 different pixel intensity values ranging from gray scale 
intensity 255 to gray scale intensity 0.  Image thresholding, also called binarization, is a 
segmentation process in which the gray scale boundary between particles of solid matter and 
void space is identified using a histogram.  Properties of the image can be quantified after a 
void/solid gray scale boundary (threshold) is determined.  In this step, the image is converted 
into binary format using the selected threshold value.   
 
Select the Image tab, Adjust option, and Threshold option.  This option allows the user to 
manually select a threshold and convert the image into binary format.  The threshold window 
displays two sliders directly below the histogram.  Move the bottom slider to the far right 
position (setting 255) and then move the top slider to a reasonable location by observing changes 
in the solid particles and void spaces in the 2-D image slice.  Based on the authors experience 
with a variety of geomaterials, a reasonable threshold value typically occurs a small distance to 
the left of the peak in the pixel distribution histogram.  As a point of comparison, Temmyo and 
Obara(9) recommend selecting the point of maximum curvature located on the upper left half of 
the histogram.  After selecting a reasonable value, click Apply.  The image is now in a binary 
format and ready for analysis. 

Step 4. 

This step involves selecting the region of interest (ROI) for subsequent analysis by eliminating 
extraneous data beyond the edge of the sample.  Select the Analyze tab, Tools option, ROI 
Manager option, More tab (last tab in the list), and Specify option.  Select Oval and then OK.  A 
yellow oval-shaped line will appear.  Use the small tabs to size the oval to encompass the sample 
by sizing and positioning the oval just inside of the dark ring that represents the sample 
container, as shown in Fig. 5.   
 

 
 
 
 

FIGURE 5.  Screen shot showing the region of interest superimposed on the 
binary image. 

region of interest (ROI) 

(example 
settings for 
ROI shown in 
this figure) 
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Step 5. 

The void ratio and porosity are calculated in this step.  In geotechnical engineering, the void ratio 
(e) is defined as: 

 v

s

VVolume of voids
e

Volume of solids V
   (1) 

 
The porosity (n) is defined as: 

 v

t

VVolume of voids
n 100% 100%

Total Volume V
     (2) 

 
Void ratio and porosity are related by:  

 n e
e or n

1 n 1 e
 

 
 (3) 

 
The void ratio and porosity of the scanned image are determined using area measurements from 
the binary image that was created in the previous steps.  Select the Analyze tab and Histogram 
option.  Select the List button from the bottom of the window and record the pixel counts at the 
gray scale value of 0 and 255.  Using the approach described in this paper, the value at 0 gray 
scale corresponds to the area of void space in square pixels and the value at 255 corresponds to 
the area of solid particles in square pixels.  Thus, e is calculated as: 
 

 (count at pixel value 0)
e

(count at pixel value 255)





 (4) 

 
Porosity is calculated as: 

 (count at pixel value 0)
n 100%

(count at pixel value 0) (count at pixel value 255)


 

  
 (5) 

Step 6. 

This step is used to develop a grain size distribution curve for the sample as represented by a 
slice or stack of slices.  Select the Analyze tab, Analyze Particles option, and input the options 
shown in Fig. 6, then click OK.  In the results window that appears, select the File tab and Save 
As option.  Save the spreadsheet file that is automatically created in a convenient folder.  The 
area column in the spreadsheet provides the area of each particle in square pixels, which is 
converted into square mm as follows: 
 

 
2

2 (container outer diameter in mm)
area of particle in (mm) (area in pixels)

(countainer outer diameter in pixels)

 
   

 
 (6) 

 
The Schedule 40 PVC sample container used by the authors had an outer diameter of 60.325 
mm.  The container outside diameter based on the digital image was 908 pixels, which is 
determined by locating the curser on the outer ring along two diametrically opposite points and 
taking the difference of the x-values shown on the screen.  The size of each particle, based on the 
area of a square, is calculated by taking the square root of the area that was determined using Eq. 
6.   
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For example, one of the larger particles in the gravel sample shown in the previous figures had a 
pixel area of 37,874 px2.  The diameter in mm is calculated as follows: 

2
2 2 260.325 mm

area (37,874 px ) 167.2 mm ; Dia 167.2 mm 12.93 mm
908 px

 
     

 
 (7) 

 

 
 
 
 
 
After converting from pixel units to mm, the data is then readily sorted and manipulated in a 
spreadsheet (Excel) to create a grain size distribution plot as shown in Fig. 7.  This is a useful 
exercise for the students because it can be compared directly to the steps used to produce a grain 
size distribution from a mechanical sieve analysis.  
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FIGURE 6.  Suggested options for analyzing particles to estimate the grain size 
distribution. 

FIGURE 7.  Grain size distribution of gravel sample from x-ray CT data. 
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Pore Size Distribution 

The pore size distribution can also be approximated using this same approach by inverting the 
histogram/thresholding procedure and creating a bimodal image in which black (255 gray scale) 
represents voids and white (0 gray scale) represents solids.  The true pore size distribution is 
quite complex and not easily measured because of the influence of tortuosity and connectivity of 
void space.  For example, a soil with low pore connectivity will measure differently than a soil 
with high connectivity, even if the pores have the same characteristic size(10).  Most experimental 
methods for measuring pore size distribution work on the fundamental principles of capillary 
pressure and related pore suction pressures.  Traditional experimental methods, including 
mercury intrusion and pressure plate suction (tensiometry) tests, are not highly accurate and 
often yield inconsistent results(11).  These methods tend to introduce testing bias in which the test 
procedures destroy or alter the same parameters they purport to measure.  Because of these 
complexities, there is no benchmark test for measuring pore size distribution.  Additional 
research and verification of pore size distributions from x-ray CT is necessary before the results 
are extended to practical applications.  Nevertheless, if the grain size distribution from x-ray CT 
matches results from mechanical sieve analyses, then it can be reasonably assumed the pore size 
distribution is at least suitable for relative comparative purposes. 

Summary and Conclusions 

Civil engineering students learn about basic geomaterial properties in the introductory 
geotechnical engineering or soil mechanics course, which is typically taken during the junior 
year of the Bachelor of Science degree program.  Introductory soils courses most often include 
laboratory sessions in which students conduct simple destructive tests such as sieve analyses, 
water content, Atterberg limits, and compaction tests.  Unfortunately, there is no standardized or 
readily implementable test for evaluating the engineering influence and significance of soil fabric 
and micro properties.  Textbooks and lectures emphasize the importance of soil texture, void 
ratio, porosity, and phase relationships; however, students often struggle with the physical 
meaning and significance of these fundamentally important parameters.   
 
A novel approach for implementing x-ray computed tomography (x-ray CT) in introductory soil 
mechanics courses was described in this paper.  A systematic method was outlined for using non-
destructive x-ray CT to quantify microscale measurements of void ratio, porosity, and grain size 
distribution of scanned digital images.  Primary benefits of this approach include: 
 

1) Students visually perceive and quantify relationships between particulates and 
voids. 

2) Students attain a better understanding of the mechanical properties of soils 
through laboratory experiments that include both simple destructive empirical 
tests and nondestructive techniques using advanced technologies that are destined 
to become prevalent during their careers. 

3) Students are excited about learning a relatively advanced technology that is 
readily adaptable to a wide range of cross-disciplinary applications.   

4) The instructor can incorporate this relatively simple approach into lessons or 
exercises currently used for teaching soil phase relationship concepts and for 
solving mass-volume relationship problems.  
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It has been the primary author’s experience that engaging geo-students in the use of x-ray CT 
technology helps alleviate a common issue in the geotechnical engineering discipline; which is, 
some students lose interest early in the semester because of the simple, low-tech, testing that is 
typically conducted during the first few weeks in introductory soils courses.  The high-tech 
flavor of x-ray CT can be attractive to these students.  Anecdotal comments from students using 
this approach have been positive and encouraging; however, the newness of this approach 
precludes the presentation of statistical assessments in this paper.  A more quantitative 
assessment of student learning will be assembled in future semesters based on additional student 
feedback. 
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